
LunarCell 
Flaming Pear Software

What it does

LunarCell is a plug-in for paint programs. It draws moons and planets.

How to install

Illustrated installation instructions are online at www.flamingpear.com/faq.html .

To use this software, you need a paint program which accepts standard 
Photoshop 3.02 plugins.

Just put the plug-in filter into the folder where your paint program expects to 
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find it. If you have Photoshop, the folder is Photoshop:Plugins:Filters or 
Photoshop:Plug-ins. You must restart Photoshop before it will notice the new 
plug-in. It will appear in the menus as Filters->Flaming Pear->LunarCell.

Most other paint programs follow a similar scheme.

If you have Paint Shop Pro: you have to create a new folder, put the plug-in filter 
into it, and then tell PSP to look there.

PSP 8, 9, X, XI, and X2:

Choose the menu File-> Preferences-> File Locations... In the dialog box that 
appears, choose Plug-ins from the list. Click “Add.” If you are using PSP 8 or 9, 
click “Browse”. Now choose the folder that contains the plug-in.

The plug-in is now installed. To use it, open any image and select an area. From 
the menus, choose Effects->Plugins->Flaming Pear->LunarCell.
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Quick start

When you invoke LunarCell, a dialog box will appear.
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If you just want to make a planet quickly, click the 
dice button until you see a planet you like; then click 
OK.

To design your own planets, you’ll need to 
familiarize yourself with the controls for each of the 
elements in a planet:

Planet

Climate

Air

Clouds

Synth clouds

Cities

...and a few other controls that affect the whole image.

Planet

 
 
  

These controls set the shape of the planet.

Size lets you choose planets from point-sized up to 
the breadth of the starting image.

Complexity specifies whether the landmasses have 
simple or complicated shapes.

Land texture sets the height of the mountains and the 
depth of the oceans, if you have oceans. A setting of 
zero will give a smooth planet.
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Crater count Besides the fractal landscape, LunarCell 
can produce craters. This isn’t the number of 
individual craters -- it’s groups of craters.

Crater size is the average size of a crater group.

When the count is high and the size is large too, 
LunarCell may overlap crater groups.

Crater texture is the roughness of the craters. It works 
just like Land texture.

If Land texture and Crater texture are both zero, you’ll 
get a smooth planet.

The Color button sets the main color of the planet.

Real Luna, when checked, gives you the shape of the 
Earth’s moon instead of the fractal terrain. When you 
use this, you may want to reduce the Land texture 
setting. It’s possible to add extra craters to the moon.

Climate

These controls let you add color to the landscape.

Ice sets the size of the planet’s polar ice caps. You can 
choose the color of the ice by clicking the color 
button.

Desert produces deserts near the equator. Use the 
color button to pick a color.

Sea level makes oceans. Set it to zero for no oceans, or 
to 100 for a drowned world. Dark blue water works 
best.
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Lunar Climate, when checked, gives you the coloration 
of Earth’s moon. The Ice, Desert, and Sea colors are 
disregarded, and the hue comes entirely from the 
planet color button.

 

Air

Your planet can have an atmosphere.

Color button sets the color of the air. Pale, muted blue 
is the most realistic.

Depth sets how far the atmosphere extends into space.

Brightness changes the brightness of the air.

Sunset influences the reddening of the light near the 
terminator (the line that separates night from day). Its 
effect is clearest when you put the light directly behind 
the planet.

Clouds

LunarCell gives you the choice of synthetic clouds or, 
with an Internet connection, real clouds from weather 
satellites. The controls in this section apply to both 
kinds of clouds.

Color button sets the clouds’ color. Off-white is the 
most realistic.
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Coverage changes the amount of clouds. (When you 
use real clouds, you can’t go up to 100% coverage — 
because the satellite pictures are not 100% cloudy.)

Edges gives the clouds a soft-edged or hard-edged 
look.

Height sets the altitude of the clouds.

Shadows sets the darkness of the clouds’ shadows.

Texture sets the amount of the clouds’ surface texture. It’s similar to Land 
texture and Crater texture.

Real Clouds checkbox will make LunarCell use weather satellite photos for the 
clouds. First you need to download these photos using the Load Clouds button.

Load Clouds button lets you download weather satellite images from the 
internet to use as clouds. This is explained below.

Synthetic clouds

There are extra controls to describe synthetic clouds.

Coriolis produces the appearance of shearing winds 
between the equator and the poles.

Viscosity sets the “soupiness” of the air. Air with 
higher viscosity has fewer small cloud details.

Storm count sets the number of hurricane-like storms.

Storm size is the size of the storms. LunarCell will not 
overlap storms. If you ask for more and larger storms 
than will fit on the planet’s face, you’ll get fewer 
storms than you asked for.

Storm spin sets the twirliness of the storms.
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Cities

 

You can add cities on the night side of the planet.

The Cities slider sets the density of the cities. Cities are 
placed mainly in coastal areas, so you may not see any 
cities at all if your planet has no oceans.

Color button sets the color of the cities. Dim, muted 
yellow works well.

 

How to download clouds

Click the Load Clouds button. This shows a window 
with a list of available cloud images.

Choose the image you want to use, and click OK. 
Clouds will be downloaded and then applied to the 
image.

If no clouds are visible, try increasing the cloud 
Coverage and Edges sliders.

The cloud chooser screen has some other buttons:

Try cache first will look to see whether the the clouds 
you’ve asked for are already on your hard disk. If so, 
LunarCell will just use those. If not, LunarCell will 
download the clouds.

Update this list will check Flaming Pear’s website to see if there is a newer list 
of clouds available. The current version number appears in the top-right corner. 
Occasionally we update the list when the images it points to move or change.

Cancel quits without changing any clouds.
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Other controls

Light control sets the light direction.

Backlighting, when checked, makes the light shine 
from behind.

Pole control moves the North Pole, influencing 
weather, climate, and city placement.

Dice: This randomizes the settings. Click it as much as 
you want to see different effects.

Reset: Gives you the factory settings.

Random seed: This changes the arrangement of all the 
random elements like land, craters, and synthetic 
clouds.

Position of planet Reposition the planet by clicking 
anywhere in the preview area.

Map mode Chooses how to draw the planet. Normal 
draws it on a black background. Composite makes the 
planet opaque, and the underlying image shows 
through the air. Other modes make flat maps and are 
explained in the Mapmaking section.

9

dice

reset

random seed

light control

pole control



Glue: Lets you combine the result image with the 
original, instead of replacing it. The next-glue button 
advances to the next glue mode.

Send to photo manager: Sends the result to iPhoto (on 
Macintosh).

Export to PSD: Saves a ten-layered Photoshop file, 
with each layer containing a different map of the 
planet. This is useful if you want to use the maps as 
textures in a 3D application.

Make Gallery: Builds a web page showing all the 
presets in a folder that you choose.

Plus, % and minus buttons: If the selected image area 
is bigger than the preview, these buttons let you zoom 
in and out. Drag the preview to move it.

Load preset: LunarCell comes with some presets, 
which are files containing settings. To load one, click 
this button and browse for a preset file.

Save preset: When you make an effect you like, click 
this button to save the settings in a file. 

Undo backs up one step.

Info: briefly explains the controls.
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Three more buttons:

OK:  Applies the effect to your image.

Cancel:  Dismisses the plug-in, and leaves the image 
unchanged.

Register: Allows you to type in a registration code and 
remove the time limit from the demo.

Memory dots

Although you can save your settings permanently to 
files, you can also stash settings in memory dots.

Click an empty dot to stash the current settings in it.

Click a full dot to retrieve its settings.

Hover the mouse over a dot to see what it contains.

Option-click to erase a dot on Macintosh.

Right-click to erase a dot on Windows.

If a dot is orange, LunarCell’s currently using that dot’s 
settings.

Dots remember their contents until you erase them. If 
you’d rather make a temporary dot that forgets when 
you exit LunarCell, control-click it. Temporary dots are 
square.

When you start LunarCell, it puts the starting settings 
in a temporary dot. That way it’s easy to start over 
without exiting the plug-in.

On Mac, you can drag-and-drop settings files from the 
central memory well.

You can build a web page showing how the current 
image would look with every memdot setting. Just 
option-click (Mac) or right-click (Windows) on the big 
memdot image.
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Mapmaking 

LunarCell can create flat maps that you can use as 
texture maps in a 3D animation program.

The maps are drawn in a cylindrical equirectangular 
projection, also known as cylindrical equidistant or 
plate carrée: meridians are vertical, parallels are 
horizontal, and all are uniformly spaced. The map will 
fill the entire selection rectangle, permitting super-
high resolution. For proper results you should start 
with a selection exactly twice as wide as it is tall.

mode view remarks

normal globe black 
background

composite globe transparent 
background

lit map map complete 
planet, lit

map color map land and sea, 
unlit

land color map land color

land bump map bump map; if 
clipping occurs, 
reduce “land 
texture” slider, 
or use 16-bit 
output.

ocean mask map antialiased 
ocean 
boundaries

air color map color of lit air; 
does not 
include the 
thickened haze 
near the 
planet’s edge.

cloud mask map opacity of cloud 
layer

cloud bump map bump map for 
clouds
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mode view remarks

cities map just the cities, 
on both day and 
night sides

mural map complete planet 
with uniform-
looking lighting

hypsometric map color-coded 
altitude with 
contour lines

If you need a complete assortment of texture maps for 
a single world, you can generate them all at once by 
using the Send to PSD button.

The “real luna” and “real clouds”” options can be used 
with maps, but since the images they use only show 
one hemisphere, they will appear duplicated on the far 
side of the planet.

If you want to build an actual physical globe of your 
LunarCell world, you can do that with Flexify. You can 
make patterns for polyhedra, gores for a traditional 
globe, and an origami balloon.

A hint

Use the “Composite” item in the map mode popup 
menu to draw the planet without the black 
background.
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Frequently Asked Questions 

 

Can it draw gas planets like Jupiter?

No.

How do I composite the planet on top of another 
image?

Click the “map mode” popup menu and choose the 
“composite” item. Now when you use LunarCell the 
planet will be…

— merged into in the background layer, or

— drawn into a transparent region in any other layer.

Sometimes when I try to increase the number of 
storms, no new storms appear.

LunarCell tries to keep storms from overlapping; 
sometimes there’s not enough room for the number of 
storms you’ve asked for. Try using smaller storms.

What does the wavy-line button do?

Think of it as the “same-but-different” button. It 
reshuffles the deck of random numbers used to build 
the planet. When you click it, your planet design 
remains materially the same, but the specific 
placement of landmasses, craters, cities, and storms 
changes.

What does the axis control do?

It says where the planet’s north pole is. It influences 
the placement of the ice cap, the deserts, the cities, 
the storms, and Coriolis winds.
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It’s awfully slow.

Yes.

The sunset control doesn’t do anything.

Its effect is subtle: it reddens the edge of the sunlit 
part of the planet. To get a good look at what it does, 
put the light directly behind the planet and then try 
different sunset settings.

I turned the cities slider up to 100, but still no cities 
appear.

Cities only appear near coastlines, so try changing the 
sea level.

I can’t download satellite clouds.

You need a working Internet connection. If your 
connection is fine but you still can’t get the clouds to 
download, it may be that the server that sends the files 
is not working. Try again later.

I downloaded some satellite clouds and the image 
is corrupted.

Sometimes the supplied pictures contain errors like 
bright horizontal lines or blank areas. LunarCell isn’t 
smart enough to fix this.

I loaded a preset that calls for real clouds, but I get 
the synthetic ones instead.

If LunarCell can’t find any clouds images on your 
computer, it will fall back to synthetic clouds. To get 
real ones again, use the cloud-downloader button.
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How often are the clouds updated?

Typically once per day.

When I’m using real clouds I can’t make the 
coverage go above 50%.

LunarCell can remove clouds from a satellite cloud 
image, but it can’t add new ones, so the control maxes 
out at 50%. If you use synthetic clouds, you can use the 
whole range of the coverage slider.

I can’t see any clouds.

Try increasing the “coverage” and “edges” sliders.

In the cloud-chooser dialog box, I clicked the 
“update this list” button, but the list didn’t change. 
Why?

The cloud list rarely changes. We only renew the list 
when one of its items stops working.

Where do the satellite clouds come from?

At the time of this writing, LunarCell is configured to 
get its cloud images from The Space Science and 
Engineering Center at the University of Wisconsin-
Madison and the Dundee Satellite Receiving Station.

I just want to make a plain picture of Earth’s moon. 
How?

Set the air depth, sunset, sea level, and crater count to 
zero. Check the “Real Luna” and “Lunar climate” 
checkboxes. Set the Land color to bright gray and set 
planet texture to about 15.
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How do I make a terraformed moon?

Start with the above recipe for a plain moon. Then 
adjust the sea-level, air depth, and clouds. If you want, 
turn off the “Lunar climate” control to get a green and 
verdant moon.

What is terraforming?

It’s the speculative technology of turning lifeless 
worlds into habitable Earth-like ones.

Does the moon have a name?

The moon’s name is Luna. It’s useful to know when 
you need to distinguish it from the several dozen other 
moons in the solar system. The sun’s name is Sol, and 
sometimes the earth is called Terra.

Where can I get more spacy pictures?

Earth & weather

NASA’s Blue Marble imagery

Live Weather Images * www.weatherimages.org

Geostationary satellite server

GOES-8/10 Full Disk and Composite Images

SSEC - NOAA GOES-8 Satellite Images

SSEC - NOAA GOES-10 Satellite Images

NOAA Home Page Main Page

EarthKAM: Main Menu

Satellite Weather Information - Weather - Net Links

PSC Weather Center

GOES-10 Current full disk visible image Colorado State 
University Cooperative Institute for Research in the 
Atmosphere

GOES-10 Current full disk visible image Colorado State 
University Cooperative Institute for Research in the 
Atmosphere

GOES GMS METEOSAT Realtime Data

GOES Full Earth
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Luna

Earth View

Lunar Outreach Services

The Galileo Moon Images

Almost a Full Moon

1st Quarter Moon

JSC Digital Image Collection - AS11-44-6667

Moon Image Index

Moon Picture List

USGS CLEMENTINE

Browser for Earth Observations from Shuttle

NASA - JSC Digital Image Collection Home

Clementine

The Living Earth

Maps of the Solar System

 

Craters

cass.jsc.nasa...c/cchome.html

Teacher Page: Impact Craters

MWO Museum Exhibit: Close-Up of Some of the 
Moon’s Craters

Impact Craters

Lunar Impact Crater Geology and Structure

NSSDC Photo Gallery: Moon

Lunar Features

Apollo 17 Metric and Panoramic Photography

Lunar and Planetary Science, winter 1998-1999, Lunar 
Mapping Lab

Solar Physics Holdings on NDADS

Encyclopedia Images
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Version history

Version 1.91

Fixes issues with stability and misaligned freeform selections in previews.

Version 1.90

64-bit version for Macintosh.

Version 1.80

64-bit version for Windows.

Version 1.76

Fixes a bug in the Mac version where some sliders would not respond.

Version 1.75

Adds convenience features to the interface. The Mac version is resizable. The 
Glue menu is now called Map Mode, but still works the same way.

Version 1.7

Universal binary for Macintosh. The planet’s size is now relative to the breadth of 
the starting image. New downloadable clouds have higher resolution.

Version 1.53

Fixes a problem where exported layers won’t open in Photoshop.

Version 1.52

Fixes a problem where craters may not appear properly.

Version 1.5
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Works with 16-bit-per-component color.

Version 1.45

Recordable as a Photoshop action.

Version 1.41

Fixes a crash that could happen when using the menus under Windows XP.

Version 1.41

Fixes the appearance of text in the interface when running under Mac OS X 
10.2.3 .

Version 1.4

Now exports multi-layered maps to Photoshop files, and has a hypsometric map 
mode. The ocean mask mode now subtracts ice cover from the oceans, so that 
it’s more useful as a specularity mask.

Version 1.3

The satellite cloud reader can now handle JPEG images, so there are six new live 
cloud sources. These replace GIFs that are no longer updated.

Version 1.2

The glue menu has been replaced with the map menu, which lets you export 
unwrapped planet elements for use in 3D animation. The storms have moved, 
because now they react correctly to the position of the planet’s pole.

Version 1.02

In newly created presets, LunarCell now pays more attention to the planet color 
setting, producing richer color variation. Presets from older versions of LunarCell 
will produce the same image as before, unless the user chooses a new planet 
color.
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Version 1.0

The first public release.
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How to purchase

You can place an order online here. A secure server for transactions is available.

Questions

The software, documentation, and supporting materials are made by Flaming 
Pear Software. Answers to common technical questions appear on our support 
page, and free updates appear periodically on the download page.

Trouble with your order? Orders are handled by Kagi; please contact them at 
admin@kagi.com .

For bug reports and technical questions about the software, please write to 
support@flamingpear.com .

©2012 Flaming Pear Software
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